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 dsPIC33CK64MC105 Curiosity Nano User's Guide

Preface
The dsPIC33CK64MC105 Curiosity Nano evaluation kit is a hardware platform to evaluate microcontrollers in the
dsPIC33CK64MC105 Family. This board has the dsPIC33CK64MC105 Digital Signal Controller (DSC) mounted.

Supported by MPLAB® X IDE, the board provides easy access to the features of the dsPIC33CK64MC105 to explore
how to integrate the device into a custom design.

The Curiosity Nano series of evaluation boards include an on-board debugger. No external tools are necessary to
program and debug the dsPIC33CK64MC105.

• MPLAB® X IDE - Software to discover, configure, develop, program, and debug Microchip microcontrollers
• Code Examples on GitHub - Get started with code examples
• dsPIC33CK64MC105 Website - Find documentation, data sheets, sample, and purchase microcontrollers
• dsPIC33CK64MC105 Curiosity Nano Website - Kit information, latest user guide, and design documentation

https://www.microchip.com/mplab/mplab-x-ide
https://www.microchip.com/doclisting/TechDoc.aspx?type=codeexamples&productfamily=16-BIT
https://www.microchip.com/en-us/product/dsPIC33CK64MC105
https://www.microchip.com/DevelopmentTools/ProductDetails.aspx?PartNO=EV88G73A
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1. Introduction

1.1 Features
• dsPIC33CK64MC105 Digital Signal Controller
• One Yellow User LED
• One Mechanical User Switch
• Footprint for 8 MHz Crystal
• On-Board Debugger:

– Board identification in Microchip MPLAB X IDE
– One green power and status LED
– Programming and debugging
– Virtual serial port (CDC)
– One debug GPIO channel (DGI GPIO)

• USB Powered
• Adjustable Target Voltage:

– MIC5353 LDO regulator controlled by the on-board debugger
– 3.0–3.6V output voltage (limited by USB input voltage)
– 500 mA maximum output current (limited by ambient temperature and output voltage)

1.2 Board Overview
The Microchip dsPIC33CK64MC105 Curiosity Nano evaluation kit is a hardware platform to evaluate the
dsPIC33CK64MC105 Digital Signal Controller.

Figure 1-1. dsPIC33CK64MC105 Curiosity Nano Board Overview
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2. Getting Started

2.1 Curiosity Nano Quick Start MPLAB Xpress
Steps to start exploring the Curiosity Nano platform with MPLAB Xpress:

1. Go to mplabxpress.microchip.com to open MPLAB Xpress.
2. Create a new standalone project for dsPIC33CK64MC105.
3. Use the MPLAB Xpress Code Configurator, or write your code.
4. Compile and download the application HEX file.
5. Connect a USB cable (Standard-A to Micro-B or Micro-AB) between the PC and the debug USB port on the

board.
6. Copy the application HEX file into the CURIOSITY mass storage drive to program the application into the

dsPIC33CK64MC105.

To use advanced debug features of the Curiosity Nano kit, package the MPLAB Xpress project for MPLAB X
IDE, and follow the quick start guide in the next section.

2.2 Quick Start
Steps to start exploring the dsPIC33CK64MC105 Curiosity Nano board:

1. Download Microchip MPLAB X IDE.
2. Download MPLAB XC C Compiler.
3. Launch MPLAB X IDE.
4. Optional: Use MPLAB® Code Configurator to generate drivers and examples.
5. Write\Develop the application code.
6. Connect a USB cable (Standard-A to Micro-B or Micro-AB) between the PC and the debug USB port on the

board.
7. Program your application onto the device.

The dsPIC33CK64MC105 device on the dsPIC33CK64MC105 Curiosity Nano board is programmed and
debugged by the on-board debugger. Therefore, no external programmer or debugger tool is required.

2.2.1 Driver Installation

When the board connects to the computer for the first time, the operating system will perform a driver software
installation. The driver file supports both 32 and 64-bit versions of Microsoft® Windows®. The drivers for the board
are included with MPLAB X IDE.

2.2.2 Kit Window

When the board is connected to a computer and powered on, the green status LED will be lit, and the MPLAB X IDE
will auto-detect which boards are connected. The Kit Window in MPLAB X IDE will present relevant information like
data sheets and board documentation.

Tip: If closed, reopen the Kit Window in MPLAB X IDE through the menu bar Window > Kit Window.

2.2.3 MPLAB X IDE Device Family Packs

Microchip MPLAB X IDE requires specific information to support devices and tools. This information is contained in
versioned packs. For the dsPIC33CK64MC105 Curiosity Nano board, MPLAB® X version 6.05 with device family

https://mplabxpress.microchip.com
https://www.microchip.com/mplab/mplab-x-ide
https://www.microchip.com/mplab/compilers
https://www.microchip.com/mplab/mplab-code-configurator
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pack “dsPIC33CK-MC_DFP” version 1.6.131 and tool pack “nEDBG_TP” version 1.11.554 or newer is required. For
more information on packs and how to upgrade them, refer to the MPLAB® X IDE User’s guide - Work with Device
Packs.

Tip: The latest device family packs are available through Tools > Packs in MPLAB X IDE or online at
Microchip MPLAB® X Packs Repository.

2.3 Design Documentation and Relevant Links
The following list contains links to the most relevant documents and software for the dsPIC33CK64MC105 Curiosity
Nano board:

• MPLAB® X IDE - MPLAB X IDE is a software program that runs on a PC (Windows®, Mac OS®, Linux®)
to develop applications for Microchip microcontrollers and digital signal controllers. It is named an Integrated
Development Environment (IDE) because it provides a single integrated “environment” to develop code for
embedded microcontrollers.

• MPLAB® XC Compilers - MPLAB® XC16 C Compiler is available as a free, unrestricted-use download.
Microchips MPLAB® XC16 C Compiler is a comprehensive solution for your project’s software development
on Windows®, macOS® or Linux®. MPLAB® XC16 supports all 16-bit PIC® MCUs and dsPIC® Digital Signal
Controllers (DSCs).

• MPLAB® Xpress Cloud-Based IDE - MPLAB Xpress Cloud-Based IDE is an online development environment
containing the most popular features of our award-winning MPLAB X IDE. This simplified and distilled
application is a faithful reproduction of our desktop-based program, allowing users an easy transition between
the two environments.

• MPLAB® Code Configurator - MPLAB Code Configurator (MCC) is a free software plug-in that provides a
graphical interface to configure peripherals and functions specific to your application.

• Microchip Sample Store - Microchip sample store where one can order samples of devices.
• MPLAB Data Visualizer - MPLAB Data Visualizer is a program used for processing and visualizing data. The

Data Visualizer can receive data from various sources, such as serial ports and the on-board debugger’s Data
Gateway Interface, as found on Curiosity Nano and Xplained Pro boards.

• dsPIC33CK64MC105 Curiosity Nano Website - Kit information, latest user guide, and design documentation
• dsPIC33CK64MC105 Curiosity Nano on Microchip Direct - Purchase this kit on Microchip Direct.

https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=MPLABX:PACKS&version=latest&redirect=true
https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=MPLABX:PACKS&version=latest&redirect=true
https://packs.download.microchip.com/
https://www.microchip.com/mplab/mplab-x-ide
https://www.microchip.com/mplab/compilers
https://www.microchip.com/mplab/mplab-xpress
https://www.microchip.com/mplab/mplab-code-configurator
https://www.microchip.com/samples/
https://www.microchip.com/en-us/development-tools-tools-and-software/embedded-software-center/mplab-data-visualizer
https://www.microchip.com/DevelopmentTools/ProductDetails.aspx?PartNO=EV88G73A
http://www.microchipdirect.com/ProductSearch.aspx?Keywords=EV88G73A
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3. Curiosity Nano
Curiosity Nano is an evaluation platform of small boards with low pin count Digital Signal Controller (DSC) boards
with on-board debuggers and access to most of the Digital Signal Controller’s I/Os. The Curiosity Nano platform
offers easy integration with MPLAB X IDE. All boards are identified in the IDE. When connected, a Kit Window
appears with links to key documentation, including relevant user guides, application notes, data sheets, and example
code. Everything is easy to find. The on-board debugger features a virtual serial port (CDC) for serial communication
to a host PC and a Data Gateway Interface (DGI) with debug GPIO pin(s).

3.1 On-Board Debugger Overview
dsPIC33CK64MC105 Curiosity Nano contains an on-board debugger for programming and debugging. The on-board
debugger is a composite USB device consisting of several interfaces:

• A debugger that can program and debug the dsPIC33CK64MC105 in MPLAB X IDE
• A mass storage device that allows drag-and-drop programming of the dsPIC33CK64MC105
• A virtual serial port (CDC) that is connected to a Universal Asynchronous Receiver/Transmitter (UART) on the

dsPIC33CK64MC105 and provides an easy way to communicate with the target application through terminal
software

• A Data Gateway Interface (DGI) for code instrumentation with logic analyzer channels (debug GPIO) to visualize
program flow

The on-board debugger controls a Power and Status LED (marked PS) on the dsPIC33CK64MC105 Curiosity Nano
board. The table below shows how the different operation modes control the LED.

Table 3-1. On-Board Debugger LED Control

Operation Mode Power and Status LED

Boot Loader mode The LED blinks slowly during power-up.

Power-up The LED is ON.

Normal operation The LED is ON.

Programming The LED blinks slowly during programming/debugging.

Drag-and-drop
programming Success: The LED blinks slowly for 2 sec.

Failure: The LED blinks rapidly for 2 sec.

Fault The LED blinks rapidly if a power fault is detected.

Sleep/Off The LED is OFF. The on-board debugger is either in a sleep mode or powered down.
This can occur if the board is externally powered.

Info: Slow blinking is approximately 1 Hz, and rapid blinking is about 5 Hz.

3.1.1 Debugger
The on-board debugger on the dsPIC33CK64MC105 Curiosity Nano board appears as a Human Interface Device
(HID) on the host computer’s USB subsystem. The debugger supports full-featured programming and debugging of
the dsPIC33CK64MC105 using MPLAB X IDE.
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Remember: Keep the debugger’s firmware up-to-date. Firmware upgrades automatically when using
MPLAB X IDE.

3.1.2 Virtual Serial Port (CDC)
The virtual serial port (CDC) is a general purpose serial bridge between a host PC and a target device.

3.1.2.1 Overview
The on-board debugger implements a composite USB device that includes a standard Communications Device Class
(CDC) interface, which appears on the host as a virtual serial port. The CDC can be used to stream arbitrary data
in both directions between the host computer and the target: All characters sent through the virtual serial port on the
host computer will be transmitted as UART on the debugger’s CDC TX pin, and UART characters captured on the
debugger’s CDC RX pin will be returned to the host computer through the virtual serial port.

Figure 3-1. CDC Connection

Target DSC
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USB
CDC RX
CDC TX

PC
Terminal
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Info: As shown in Figure 3-1, the debugger’s CDC TX pin is connected to a UART RX pin on the target
for receiving characters from the host computer. Similarly, the debugger’s CDC RX pin is connected to a
UART TX pin on the target for transmitting characters to the host computer.

3.1.2.2 Operating System Support
On Windows® machines, the CDC will enumerate as Curiosity Virtual COM Port and appear in the Ports section of
the Windows Device Manager. The COM port number can also be found there.

Info: On older Windows systems, the CDC requires a USB driver. The MPLAB X IDE installation
Includes this driver.

On Linux® machines, the CDC will enumerate and appear as /dev/ttyACM#.

Info: tty* devices belong to the “dialout” group in Linux, so it may be necessary to become a member of
that group to have permission to access the CDC.

On Mac® machines, the CDC will enumerate and appear as /dev/tty.usbmodem#. Depending on the terminal
program used, it will appear in the available list of modems as usbmodem#.
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Info: For all operating systems, use a terminal emulator that supports DTR signaling. See
3.1.2.4.  Signaling.

3.1.2.3 Limitations
Not all UART features are implemented in the on-board debugger CDC. The constraints are outlined here:

• Baud rate: Must be in the range of 1200 bps to 500 kbps. Any baud rate outside this range will be set to the
closest limit without warning. Baud rate can be changed on-the-fly.

• Character format: Only 8-bit characters are supported.
• Parity: Can be odd, even, or none.
• Hardware flow control: Not supported.
• Stop bits: One or two bits are supported.

3.1.2.4 Signaling
During USB enumeration, the host OS will start both the communication and data pipes of the CDC interface. At this
point, it is possible to set and read back the baud rate and other UART parameters of the CDC, but data sending and
receiving will not be enabled.

The terminal must assert the DTR signal when it connects to the host. As this is a virtual control signal implemented
on the USB interface, it is not physically present on the board. Asserting the DTR signal from the host will indicate to
the on-board debugger that a CDC session is active. The debugger will enable its level shifters (if available) and start
the CDC data send and receive mechanisms.

Deasserting DTR in debugger firmware version 1.20 or earlier has the following behavior:
• Debugger UART receiver is disabled, and no further data will be transferred to the host computer
• Debugger UART transmitter will continue to send queued data ready for transfer, but no new data is accepted

from the host computer
• Level shifters (if available) are not disabled, and the debugger CDC TX line remains driven

Deasserting DTR in debugger firmware version 1.21 or later has the following behavior:
• Debugger UART receiver is disabled, and no further data will be transferred to the host computer
• Debugger UART transmitter will continue to send queued data ready for transfer, but no new data is accepted

from the host computer
• Once the ongoing transmission is complete, level shifters (if available) are disabled, and the debugger CDC TX

line will become high-impedance

Remember: Set up the terminal emulator to assert the DTR signal. Without the signal, the on-board
debugger will not send or receive data through its UART.

Tip: The on-board debugger’s CDC TX pin will not be driven until the CDC interface is enabled by the
host computer. Also, there are no external pull-up resistors on the CDC lines connecting the debugger
and the target, which means that the lines are floating during power-up.The target device may enable the
internal pull-up resistor on the pin connected to the debugger’s CDC TX pin to avoid glitches resulting in
unpredictable behavior like framing errors.
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3.1.2.5 Advanced Use

CDC Override Mode
In normal operation, the on-board debugger is a true UART bridge between the host and the device. However, in
certain use cases, the on-board debugger can override the basic operating mode and use the CDC TX and RX pins
for other purposes.

Dropping a text file into the on-board debugger’s mass storage drive can be used to send characters out of the
debugger’s CDC TX pin. The filename and extension are trivial, but the text file must start with the characters:
CMD:SEND_UART=

Debugger firmware version 1.20 or earlier has the following limitations:
• The maximum message length is 50 characters – all remaining data in the frame are ignored
• The default baud rate used in this mode is 9600 bps, but if the CDC is already active or has been configured,

the previously used baud rate still applies

Debugger firmware version 1.21 and later has the following limitations/features:
• The maximum message length may vary depending on the MSC/SCSI layer timeouts on the host computer

and/or operating system. A single SCSI frame of 512 bytes (498 characters of payload) is ensured, and files of
up to 4 KB will work on most systems. The transfer will complete on the first NULL character encountered in the
file.

• The baud rate used is always 9600 bps for the default command:
CMD:SEND_UART=

• Do not use the CDC override mode simultaneously with data transfer over the CDC/terminal. If a CDC terminal
session is active at the time a file is received via CDC Override mode, it will be suspended for the duration of the
operation and resumed once complete.

• Additional commands are supported with explicit baud rates:
CMD:SEND_9600=

CMD:SEND_115200=

CMD:SEND_460800=

USB-Level Framing Considerations
Sending data from the host to the CDC can be done byte-wise or in blocks, which will be chunked into 64-byte USB
frames. Each such frame will be queued up for sending to the debugger’s CDC TX pin. Transferring a small amount
of data per frame can be inefficient, particularly at low baud rates, as the on-board debugger buffers frames and not
bytes. A maximum of four 64-byte frames can be active at any time. The on-board debugger will throttle the incoming
frames accordingly. Sending full 64-byte frames containing data is the most efficient method.

When receiving data on the debugger’s CDC RX pin, the on-board debugger will queue up the incoming bytes into
64-byte frames, which are sent to the USB queue for transmission to the host when they are full. Incomplete frames
are also pushed to the USB queue at approximately 100 ms intervals, triggered by USB start-of-frame tokens. Up to
eight 64-byte frames can be active at any time.

If the host (or the software running on it) fails to receive data fast enough, an overrun will occur. When this happens,
the last-filled buffer frame will be recycled instead of being sent to the USB queue, and a full data frame will be lost.
To prevent this occurrence, the user must ensure that the CDC data pipe is being read continuously, or the incoming
data rate must be reduced.

3.1.3 Mass Storage Device
The on-board debugger includes a simple Mass Storage Device implementation, which is accessible for read/write
operations via the host operating system to which it is connected.

It provides:
• Read access to basic text and HTML files for detailed kit information and support
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• Write access for programming Intel® HEX formatted files into the target device’s memory
• Write access for simple text files for utility purposes

3.1.3.1 Mass Storage Device Implementation
The on-board debugger implements a highly optimized variant of the FAT12 file system having several limitations,
partly due to the nature of FAT12 itself and optimizations made to fulfill its purpose for its embedded application.

The Curiosity Nano USB device is USB Chapter 9-compliant as a mass storage device but does not, in any way, fulfill
the expectations of a general purpose mass storage device. This behavior is intentional.

When using the Windows operating system, the on-board debugger enumerates as a Curiosity Nano USB Device
found in the disk drives section of the device manager. The CURIOSITY drive appears in the file manager and claims
the following available drive letter in the system.

The CURIOSITY drive contains approximately one MB of free space and does not reflect the target device’s Flash
size. When programming an Intel HEX file, the binary data are encoded in ASCII with metadata providing a large
overhead, so 1 MB is a trivially chosen value for disk size.

It is not possible to format the CURIOSITY drive. The filename may appear in the disk directory listing when
programming a file to the target, which is merely the operating system’s view of the directory that, in reality, has not
been updated. It is not possible to read out the file contents. Removing and replugging the board will return the file
system to its original state, but the target will still contain the previously programmed application.

Copy a text file starting with “CMD:ERASE” onto the disk to erase the target device.

By default, the CURIOSITY drive contains several read-only files for generating icons as well as reporting status and
linking to further information:

• AUTORUN.ICO – icon file for the Microchip logo
• AUTORUN.INF – system file required for Windows Explorer to show the icon file
• KIT-INFO.HTM – redirect to the development board website
• KIT-INFO.TXT – a text file containing details about the board’s debugger firmware version, board name, USB

serial number, device, and drag-and-drop support
• STATUS.TXT – a text file containing the programming status of the board

Info: STATUS.TXT is dynamically updated by the on-board debugger. The contents may be cached by the
OS and, therefore, may not reflect the correct status.

3.1.3.2 Configuration Words

Configuration Words (PIC® MCU Targets)
Configuration Word settings are included in the project after Flash is programmed. The debugger will not mask out
any bits in the Configuration Words when writing them. For example, if the incorrect clock source is selected and the
board does not boot, it is always possible to perform a bulk erase (always done before programming) and restore the
device to its default settings.

3.1.3.3 Special Commands
Several utility commands are supported by copying text files to the mass storage disk. The filename or extension is
irrelevant – the command handler reacts to content only.

Table 3-2. Special File Commands

Command Content Description

CMD:ERASE Executes a chip erase of the target.

CMD:SEND_UART= Sends a string of characters to the CDC UART. See “CDC
Override Mode.”
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...........continued
Command Content Description

CMD:SEND_9600=
CMD:SEND_115200=
CMD:SEND_460800=

Sends a string of characters to the CDC UART at the specified
baud rate. Note that only the baud rates explicitly specified here
are supported. See “CDC Override Mode.” (Debugger firmware
v1.25.6 or newer.)

CMD:RESET Resets the target device by entering Programming mode and
exiting Programming mode immediately afterward. The exact
timing can vary according to the programming interface of the
target device. (Debugger firmware v1.25.6 or newer.)

CMD:POWERTOGGLE Powers down the target and restores it after a 100 ms delay.
If external power is provided, this has no effect. (Debugger
firmware v1.25.6 or newer.)

CMD:0V Powers down the target device by disabling the target supply
regulator. If external power is provided, this has no effect.
(Debugger firmware v1.25.6 or newer.)

CMD:1V8 Sets the target voltage to 1.8V. If external power is provided,
this has no effect. (Debugger firmware v1.25.6 or newer.)

CMD:3V3 Sets the target voltage to 3.3V. If external power is provided,
this has no effect. (Debugger firmware v1.25.6 or newer.)

Info: The content sent to the mass storage emulated disk triggers the commands listed here and provides
no feedback in the case of either success or failure.

3.1.4 Data Gateway Interface (DGI)
Data Gateway Interface (DGI) is a USB interface for transporting raw and timestamped data between on-board
debuggers and host computer-based visualization tools. MPLAB Data Visualizer is used on the host computer to
display any debug GPIO data. It is available as a plug-in for MPLAB X IDE or a stand-alone application that can be
used in parallel with MPLAB® X IDE.

Although DGI encompasses several physical data interfaces, the dsPIC33CK64MC105 Curiosity Nano
implementation includes logic analyzer channels:

• One debug GPIO channel (also known as DGI GPIO)

3.1.4.1 Debug GPIO
Debug GPIO channels are timestamped digital signal lines connecting the target application to a host computer
visualization application. They are typically used to plot low-frequency events on a time axis, such as when given
Application state transitions occur.

The figure below shows the monitoring of the Digital state of a mechanical switch connected to a debug GPIO in
MPLAB Data Visualizer.

https://www.microchip.com/en-us/development-tools-tools-and-software/embedded-software-center/mplab-data-visualizer
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Figure 3-2. Monitoring Debug GPIO with MPLAB Data Visualizer

Debug GPIO channels are timestamped, so the resolution of DGI GPIO events is determined by the resolution of the
DGI Timestamp module.

Important: Although signal bursts of higher frequency can be captured, the frequency range of signals for
which debug GPIO can be used is up to about 2 kHz. Attempting to capture signals above this frequency
will result in data saturation and overflow, which may cause the DGI session to be aborted.

3.1.4.2 Timestamping
DGI sources are timestamped when they are captured by the debugger. The timestamp counter implemented in the
Curiosity Nano debugger increments at a 2 MHz frequency, providing a timestamp resolution of a half microsecond.

3.2 Curiosity Nano Standard Pinout
The 12 edge connections closest to the USB connector on Curiosity Nano boards have a standardized pinout. The
program/debug pins have different functions depending on the target programming interface, as shown in the table
and figure below.

Table 3-3. Curiosity Nano Standard Pinout

Debugger Signal Target MCU Description

ID — ID line for extensions

CDC TX UART RX USB CDC TX line

CDC RX UART TX USB CDC RX line

DBG0 ICSPDAT Debug data line

DBG1 ICSPCLK Debug clock line

DBG2 GPIO0 Debug GPIO0

DBG3 MCLR Reset line

NC — No connect
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...........continued
Debugger Signal Target MCU Description

VBUS — VBUS voltage for external use

VOFF — Voltage Off input. Disables the target regulator and
target voltage when pulled low.

VTG — Target voltage

GND — Common ground

Figure 3-3. Curiosity Nano Standard Pinout
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3.3 Power Supply
The USB port powers the board. It contains two LDO regulators, one to generate 3.3V for the on-board debugger
and an adjustable LDO regulator for the target dsPIC33CK64MC105 Digital Signal Controller and its peripherals.
The voltage from a USB connector can vary between 4.4V and 5.25V (according to the USB specification) and
will limit the maximum voltage supplied to the target. The figure below shows the entire power supply system on
dsPIC33CK64MC105 Curiosity Nano.

Figure 3-4. Power Supply Block Diagram
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3.3.1 Target Regulator
The target voltage regulator is a MIC5353 variable output LDO. The on-board debugger can adjust the voltage output
supplied to the board target section by manipulating the MIC5353’s feedback voltage. The hardware implementation
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is limited to an approximate voltage range from 1.7V to 5.1V. Additional output voltage limits are configured in the
debugger firmware to ensure that the output voltage never exceeds the hardware limits of the dsPIC33CK64MC105
Digital Signal Controller. The voltage limits configured in the on-board debugger on dsPIC33CK64MC105 Curiosity
Nano are 3.0–3.6V.

Info: The target voltage is set to 3.3V when the board is manufactured. It can be changed through the
MPLAB X IDE project properties. Any change to the target voltage is persistent, even after a power toggle.
The resolution is less than 5 mV but may be limited to 10 mV by the adjustment program.

Info: The voltage settings setup in MPLAB X IDE is not applied immediately to the board. The new
voltage setting is applied to the board when accessing the debugger, like pushing the Refresh Debug Tool
Status button in the project dashboard tab or programming/reading program memory.

Info: There is an easy option to adjust the target voltage with a drag-and-drop command text file to the
board, which supports a set of common target voltages. See section 3.1.3.3.  Special Commands for
further details.

Note: Max input voltage of dsPIC33CK64MC105 should never exceed 3.6V. Exceeding the max input could cause
permanent damage to the device.

The MIC5353 supports a maximum current load of 500 mA. It is an LDO regulator in a small package, placed on a
small printed circuit board (PCB), and the thermal shutdown condition can be reached at lower loads than 500 mA.
The maximum current load depends on the input voltage, the selected output voltage, and the ambient temperature.
The figure below shows the safe operating area for the regulator, with an input voltage of 5.1V and an ambient
temperature of 23°C.

Figure 3-5. Target Regulator Safe Operation Area
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The voltage output of the target regulator is continuously monitored (measured) by the on-board debugger. If it is
more than 100 mV over/under the set device voltage, an error condition will be flagged, and the target voltage
regulator will be switched off, detecting and handling any short-circuit conditions. It will also detect and handle if an
external voltage, which causes VCC_TARGET to move outside the voltage setting monitoring window of ±100 mV, is
suddenly applied to the VTG pin without setting the VOFF pin low.



 
Curiosity Nano

© 2022 Microchip Technology Inc.
and its subsidiaries

 User Guide DS70005517A-page 16

Info: The on-board debugger has a monitoring window of VCC_TARGET±100 mV. The on-board debugger
status LED will blink rapidly if the external voltage is under this limit. The on-board debugger status LED
will continue to shine if the external voltage is above this limit. When removing the external voltage, the
status LED will start blinking rapidly until the on-board debugger detects the new situation and turns the
target voltage regulator back on.

3.3.2 External Supply
Instead of the on-board target regulator, an external voltage can power the dsPIC33CK64MC105 Curiosity Nano.
When shorting the Voltage Off (VOFF) pin to the ground (GND) pin, the on-board debugger firmware disables the
target regulator, and it is safe to apply an external voltage to the VTG pin.

It is also safe to apply an external voltage to the VTG pin when no USB cable is plugged into the DEBUG connector
on the board.

The VOFF pin can be tied low/let go at any time, which will be detected by a pin-change interrupt to the on-board
debugger, which controls the target voltage regulator accordingly.

WARNING
Applying an external voltage to the VTG pin without shorting VOFF to GND may cause permanent damage
to the board.

WARNING
Do not apply any voltage to the VOFF pin. Let the pin float to enable the power supply.

WARNING
The absolute maximum external voltage is 5.5V for the on-board level shifters, and the standard operating
condition of the dsPIC33CK64MC105 is 3.0–3.6V. Applying a higher voltage may cause permanent
damage to the board.

Info: If an external voltage is applied without pulling the VOFF pin low and an external supply pulls the
voltage lower than the monitoring window’s lower limit (target voltage setting – 100 mV), the on-board
debugger status LED will blink rapidly and shut the on-board regulator off. If an external voltage is
suddenly removed when the VOFF pin is not pulled low, the status LED will start to blink rapidly until the
on-board debugger detects the new situation and switches the target voltage regulator back on.

Programming, debugging, and data streaming are still possible with an external power supply. The USB cable will
power the debugger and signal level shifters. Both regulators, the debugger, and the level shifters are powered down
when the USB cable is removed.

Info: In addition to the power consumed by the dsPIC33CK64MC105 and its peripherals, approximately
100 µA will be drawn from any external power source to power the on-board level shifters and voltage
monitor circuitry when a USB cable is plugged into the DEBUG connector on the board. When a USB
cable is not plugged in, some current is used to supply the level shifter’s voltage pins, which have a
worst-case current consumption of approximately 5 µA. Typical values may be as low as 100 nA.

3.3.3 VBUS Output Pin
dsPIC33CK64MC105 Curiosity Nano has a VBUS output pin that can be used to power external components that
need a 5V supply. The VBUS output pin has a PTC fuse to protect the USB against short circuits. A side effect of the
PTC fuse is a voltage drop on the VBUS output with higher current loads. The chart below shows the voltage versus
the current load of the VBUS output.
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Figure 3-6. VBUS Output Voltage vs. Current

3.3.4 Power Supply Exceptions
This chapter sums up most exceptions that can occur with the power supply.

Target Voltage Shuts Down
Not reaching the target voltage setting can happen if the target section draws too much current at a given voltage and
cause the thermal shutdown safety feature of the MIC5353 regulator to kick in. To avoid this, reduce the current load
of the target section.

Target Voltage Setting is Not Reached
The USB input voltage (specified to be 4.4V-5.25V) limits the maximum output voltage of the MIC5353 regulator at
a given voltage setting and current consumption. If a higher output voltage is needed, use a USB power source that
can provide a higher input voltage or use an external voltage supply on the VTG pin.

Target Voltage is Different From Setting
An externally applied voltage to the VTG pin without setting the VOFF pin low can cause this. If the target voltage
differs more than 100 mV over/under the voltage setting, the on-board debugger will detect it, and the internal voltage
regulator will shut down. To fix this issue, remove the applied voltage from the VTG pin, and the on-board debugger
will enable the on-board voltage regulator when the new condition is detected. Note that the PS LED will blink rapidly
if the target voltage is below 100 mV of the setting but will ordinarily turn on when higher than 100 mV above the
setting.

No, Or Very Low Target Voltage, and PS LED is Blinking Rapidly
A full or partial short circuit can cause this and is a particular case of the issue mentioned above. Remove it, and the
on-board debugger will re-enable the on-board target voltage regulator.
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No Target Voltage and PS LED is Lit 1
This occurs if the target voltage is set to 0.0V. To fix this, set the target voltage to a value within the specified voltage
range for the target device.

No Target Voltage and PS LED is Lit 2
This can be the issue if power jumper J100 and/or J101 is cut, and the target voltage regulator is set to a value within
the specified voltage range for the target device. To fix this, solder a wire/bridge between the pads for J100/J101, or
add a jumper on J101 if a pin-header is mounted.

VBUS Output Voltage is Low or Not Present
If the VBUS output voltage is low or missing, the reason is probably a high-current drain on VBUS, and the protection
fuse (PTC) will reduce the current or cut off completely. Reduce the current consumption on the VBUS pin to fix this
issue.

3.4 Low-Power Measurement
Power to the dsPIC33CK64MC105 is connected from the on-board power supply and VTG pin through a 100 mil pin-
header marked with “POWER” in silkscreen (J101). To measure the power consumption of the dsPIC33CK64MC105
and other peripherals connected to the board, cut the Target Power strap and connect an ammeter over the strap.

To measure the lowest possible power consumption, follow these steps:
1. Cut the POWER strap with a sharp tool.
2. Solder a 1x2 100 mil pin-header in the footprint.
3. Connect an ammeter to the pin header.
4. Write firmware that:

a. Tri-states any I/O connected to the on-board debugger.
b. Sets the Digital Signal Controller in its lowest Power sleep mode.

5. Program the firmware into the dsPIC33CK64MC105.

Figure 3-7. Target Power Strap

Target Power strap (top side)



 
Curiosity Nano

© 2022 Microchip Technology Inc.
and its subsidiaries

 User Guide DS70005517A-page 19

Tip: A 100-mil pin-header can be soldered into the Target Power strap (J101) footprint for a simple
connection of an ammeter. Place a jumper cap on the pin-header once the ammeter is no longer needed.

Info: The on-board level shifters will draw a small amount of current even when not used. Maximum
2 µA can be drawn from each I/O pin connected to a level shifter, the worst case maximum for the 5
on-board level shifters is therefore 10 µA. Keep any I/O pin connected to a level shifter in tri-state to
prevent leakage. All I/Os connected to the on-board debugger are listed in 4.2.4.1.  On-Board Debugger
Connections. The on-board level shifters can be completely disconnected to prevent leakage, as described
in 7.4.  Disconnecting the On-Board Debugger.

3.5 Programming External Digital Signal Controllers
The on-board debugger on dsPIC33CK64MC105 Curiosity Nano can be used to program and debug Digital Signal
Controllers on external hardware.

3.5.1 Supported Devices
All external AVR microcontrollers with the UPDI interface can be programmed and debugged with the on-board
debugger with Microchip Studio.

External SAM microcontrollers having a Curiosity Nano Board can be programmed and debugged with the on-board
debugger with Microchip Studio.

dsPIC33CK64MC105 Curiosity Nano can program and debug external dsPIC33CK64MC105 microcontrollers with
MPLAB X IDE.

3.5.2 Software Configuration
No software configuration is required to program and debug the same device mounted on the board.

To program and debug a different digital signal controller than the one mounted on the board, configure Microchip
Studio to allow an independent selection of devices and programming interfaces.

1. Navigate to Tools > Options through the menu system at the top of the application.
2. Select the Tools > Tool settings category in the options window.
3. Set the Hide unsupported devices option to False.
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Figure 3-8. Hide Unsupported Devices

Info:  Microchip Studio allows any digital signal controller and interface to be selected when the Hide
unsupported devices setting is set to False, including digital signal controllers and interfaces not
supported by the on-board debugger.

3.5.3 Hardware Modifications
The on-board debugger is connected to the dsPIC33CK64MC105 by default. Remove these connections before any
external microcontroller can be programmed or debugged. Cut the GPIO straps shown in the figure below with a
sharp tool to disconnect the dsPIC33CK64MC105 from the on-board debugger.
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Figure 3-9. Programming and Debugging Connections to Debugger

GPIO straps (bottom side)

Info: Cutting the connections to the debugger will disable programming, debugging, and data streaming
from the dsPIC33CK64MC105 mounted on the board.

Tip: Solder 0Ω resistors across the footprints or short circuit them with solder to reconnect the signals
between the on-board debugger and the dsPIC33CK64MC105.

3.5.4 Connecting to External Microcontrollers
The figure and table below show where to connect the programming and debugging signals to program and debug
external microcontrollers. The on-board debugger can supply power to the external hardware or use an external
voltage as a reference for its level shifters. Read more about the power supply in 3.3.  Power Supply.

The on-board debugger and level shifters actively drive data and clock signals used for programming and debugging
(DBG0, DBG1, and DBG2). Pull-down resistors are required on the ICSP™ data and clock signals to debug PIC®

microcontrollers. All other interfaces are functional with or without pull-up or pull-down resistors.

DBG3 is an open-drain connection and requires a pull-up resistor to function.

dsPIC33CK64MC105 Curiosity Nano has pull-down resistors R201 and R204 connected to the ICSP data and clock
signal (DBG0 and DBG1). There is also a pull-up resistor R205 connected to the MCLR signal (DBG3). The location
of pull resistors is shown in 7.2.  Assembly Drawing in the appendix.

Remember: 
• Connect GND and VTG to the external microcontroller
• Tie the VOFF pin to GND if the external hardware has a power supply
• Make sure there are pull-down resistors on the ICSP data and clock signals (DBG0 and DBG1) to

support the debugging of PIC microcontrollers
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Figure 3-10. Curiosity Nano Standard Pinout
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Table 3-4. Programming and Debugging Interfaces

Curiosity Nano Pin UPDI ICSP™ SWD

DBG0 UPDI DATA SWDIO

DBG1 — CLK SWCLK

DBG2 — — —

DBG3 — MCLR RESET

3.6 Connecting External Debuggers
Even though there is an on-board debugger, external debuggers can be connected directly to the
dsPIC33CK64MC105 Curiosity Nano to program/debug the dsPIC33CK64MC105. When not actively used, the
on-board debugger keeps all the pins connected to the dsPIC33CK64MC105 and board edge in tri-state. Therefore,
the on-board debugger will not interfere with any external debug tools.
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Figure 3-11. Connecting the MPLAB® PICkit™ 4 In-Circuit Debugger/Programmer to dsPIC33CK64MC105
Curiosity Nano
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CAUTION
The MPLAB® PICkit™ 4 In-circuit Debugger/Programmer can deliver high voltage on the MCLR pin. High
voltage can permanently damage R110. If R110 is broken, the on-board debugger cannot enter the
programming mode of the dsPIC33CK64MC105 and will typically fail at reading the device ID.

CAUTION
To avoid contention between the external debugger and the on-board debugger, do not start any
programming/debug operation with the on-board debugger through MPLAB® X IDE or mass storage
programming while the external tool is active.
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4. Hardware User Guide

4.1 Connectors

4.1.1 dsPIC33CK64MC105 Curiosity Nano Pinout
All the dsPIC33CK64MC105 I/O pins are accessible at the edge connectors on the board. The image below shows
the board pinout.

Figure 4-1. dsPIC33CK64MC105 Curiosity Nano Pinout
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Info:  Peripheral signals shown in the image above, such as UART, I2C, SPI, ADC, PWM, and others, are
shown at specific pins to comply with the Curiosity Nano Board standard. These signals can usually be
routed to alternate pins using the Peripheral Pin Select (PPS) feature in the dsPIC33CK64MC105.
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4.1.2 Using Pin-Headers
The edge connector footprint on dsPIC33CK64MC105 Curiosity Nano has a staggered design where each hole is
shifted 8 mil (~0.2 mm) off-center. The hole shift allows regular 100 mil pin-headers to be used without soldering on
the board. The pin-headers can be used in applications like pin sockets and prototyping boards without issues once
they are firmly in place.

Figure 4-2. Attaching Pin-Headers to the Curiosity Nano Board

Figure 4-3. Connecting to Curiosity Nano Base for Click boards

Tip: Start at one end of the pin-header and gradually insert the header along the length of the board.
Once all the pins are in place, use a flat surface to push them in.

Tip: For applications where the pin-headers will be used permanently, it is still recommended to solder
them in place.

Important: Once the pin-headers are in place, they are hard to remove by hand. Use a set of pliers and
carefully remove the pin-headers to avoid damage to the pin-headers and PCB.

4.2 Peripherals

4.2.1 LED
One yellow user LED is available on the dsPIC33CK64MC105 Curiosity Nano board. It can be controlled by either
GPIO or PWM. Driving the connected I/O line to GND can also activate the LED.
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Table 4-1. LED Connection

dsPIC33CK64MC105 Pin Function Shared Functionality

RD10 Yellow LED0 Edge connector

4.2.2 Mechanical Switch
The dsPIC33CK64MC105 Curiosity Nano board has one mechanical switch - a generic user-configurable switch.
Pressing it will connect the I/O pin to ground (GND).

Tip: There is no externally connected pull-up resistor on the switch. The internal pull-up resistor on pin
RD13 must be enabled to use the switch.

Table 4-2. Mechanical Switch

dsPIC33CK64MC105 Pin Description Shared Functionality

RD13 User switch (SW0) Edge connector, On-board debugger

4.2.3 Crystal
The dsPIC33CK64MC105 Curiosity Nano is provisioned for an 8 MHz crystal. The crystal is not connected to the
dsPIC33CK64MC105 by default because the GPIOs are routed out to the edge connector. To use the crystal, some
hardware modifications are required. The crystal Y201 (Abracon ABM3B-8.000MHZ-10-1-U-T), and the capacitors
C206, C207 (Murata GJM1555C1H100JB01D) or comparable parts, must be mounted on the board. The two I/O
lines routed to the edge connector should be disconnected to reduce the chance of contention to the crystal, and to
remove excessive capacitance on the lines. This can be done by cutting the two straps on the bottom side of the
board, marked RB0 and RB1 as shown in Figure 4-4. Next, add solder to each of the circular solder points next to the
crystal on the top side of the board as shown in Figure 4-5.

Table 4-3. Crystal I/O

dsPIC33CK64MC105 Function Shared Functionality

RB0 OSCI Edge connector

RB1 OSCO Edge connector

Figure 4-4. RBO and RB1

Figure 4-5. Circular Solder Point Locations

4.2.4 On-Board Debugger Implementation
dsPIC33CK64MC105 Curiosity Nano features an on-board debugger that can be used to program and debug the
dsPIC33CK64MC105 using UPDI / ICSP. The on-board debugger also includes a virtual serial port (CDC) interface



 
Hardware User Guide

© 2022 Microchip Technology Inc.
and its subsidiaries

 User Guide DS70005517A-page 27

over UART and debug GPIO. MPLAB® X IDE can be used as a front-end for the on-board debugger for programming
and debugging. MPLAB Data Visualizer can be used as a front-end for the CDC and debug GPIO.

4.2.4.1 On-Board Debugger Connections
The table below shows the connections between the target and the debugger section. All the connections between
the target and the debugger are tri-stated when the debugger is not using the interface. Hence, there are few
contaminations of the signals, e.g., the pins can be configured to anything the user wants.

For further information on how to use the capabilities of the on-board debugger, see 3.1.  On-Board Debugger
Overview.

Table 4-4. On-Board Debugger Connections

dsPIC33CK64MC105
Pin

Debugger
Pin

Function Shared Functionality

RC11 CDC TX UART RX (dsPIC33CK64MC105 RX
line)

Edge connector

RC10 CDC RX UART TX (dsPIC33CK64MC105 TX
line)

Edge connector

RB5 DBG0 PGD3 Edge connector

RB6 DBG1 PGC3 Edge connector

RD13 DBG2 SW0/GPIO Edge connector

MCLR DBG3 MCLR Edge connector

https://www.microchip.com/en-us/development-tools-tools-and-software/embedded-software-center/mplab-data-visualizer
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5. Hardware Revision History and Known Issues
This user guide provides information about the latest available revision of the board. The following sections contain
information about known issues, a revision history of older revisions, and how older revisions differ from the latest
revision.

5.1 Identifying Product ID and Revision
There are two ways to find the revision and product identifier of the dsPIC33CK64MC105 Curiosity Nano: Either by
utilizing the MPLAB X IDE Kit Window or by looking at the sticker on the bottom of the PCB.

The Kit Window will pop up when connecting dsPIC33CK64MC105 Curiosity Nano to a computer with MPLAB X
IDE running. The first six digits of the serial number, listed under kit information, contain the product identifier and
revision.

Tip:  If closed, the Kit Window can be opened in MPLAB X IDE through the menu bar Window > Kit
Window.

The same information is found on the sticker on the bottom side of the PCB. Most boards will have the identifier,
revision, serial number, and manufacturing date printed in plain text as 02-nnnn\rr SN: mmmssssss [Manufacturing
date], where “nnnn” is the identifier, “rr” is the revision, "mmm" is the manufacturer, and "ssssss" is the serial number.

The serial number string has the following format:

"nnnnnnrrmmmssssss"

n = product identifier

r = revision

m = manufacturer

s = serial number

The product identifier for dsPIC33CK64MC105 Curiosity Nano is 02-00236.

5.2 Revision 2
Revision 2 is the initially released version.
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6. Document Revision History
Revision A (September 2022)

This is the initial version of the document.
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7. Appendix

7.1 Schematic
Figure 7-1. dsPIC33CK64MC105 Curiosity Nano Schematic

11

22

33

44

55

66

77

88

D
D

C
C

B
B

A
A

ds
P

IC
33

C
K

64
M

C
10

5 
C

u
ri

os
it

y 
N

an
o

03
-1

13
56

_C
ur

io
si

ty
_N

an
o_

D
eb

ug
ge

r.S
ch

D
oc

Pr
oj

ec
t T

it
le

F
il

e:

D
es

ig
n

ed
 w

it
h

P
C

B
 L

ay
ou

t C
on

ta
ct

:
P 

B
re

ed
ve

ld

Sh
ee

t T
it

le

D
eb

ug
ge

r

P
ro

je
ct

 O
w

ne
r:

P 
Y

ed
am

al
e

S
iz

e
A

3

E
V

88
G

73
A

P
ar

tN
um

be
r:

V
ar

ia
nt

:
D

ef
au

lt 
A

ss
em

bl
y

3 
of

 4
8/

2/
20

22
S

C
H

 #
:

D
at

e:
S

he
et

03
-0

02
36

2
P

C
B

 #
:0

4-
11

35
6

R
ev

:
R

ev
:

2
A

lt
iu

m
.c

om

S
R

S
T

ST
A

T
U

S
_L

E
D

V
C

C
_P

3V
3

D
B

G
0

D
B

G
0

U
S

B
D

_P
U

S
B

D
_N

V
C

C
_M

C
U

_C
O

R
E

V
C

C
_P

3V
3

V
C

C
_P

3V
3

V
C

C
_P

3V
3

D
B

G
2

D
B

G
3_

C
T

R
L

S
1_

0_
T

X
S

1_
1_

R
X

S
0_

2_
T

X

D
A

C
V

T
G

_A
D

C

R
E

SE
R

V
E

D

S
0_

3_
C

L
K

DBG0_CTRL

C
D

C
_T

X
_C

T
R

L

B
O

O
T

V
C

C
_L

E
V

E
L

V
C

C
_R

E
G

U
L

A
T

O
R

D
B

G
1

C
D

C
_R

X

C
D

C
_T

X

D
B

G
3

DBG1_CTRL

REG_ENABLE

R
E

G
_E

N
A

B
L

E

V
C

C
_L

E
V

E
L

S
W

C
L

K

D
B

G
2

S
0_

0_
R

X

D
B

G
1_

C
T

R
L

D
B

G
0_

C
T

R
L

D
B

G
3 

O
P

E
N

 D
R

A
IN

T
A

R
G

E
T

A
D

JU
ST

A
B

L
E

R
E

G
U

L
A

T
O

R

SRST

D
E

B
U

G
G

E
R

 T
E

S
T

P
O

IN
T DBG2_CTRL

V
O

F
F

C
D

C
_R

X
_C

T
R

L

D
B

G
1

C
D

C
_T

X
_C

T
R

L

C
D

C
_R

X
_C

T
R

L

S
W

C
L

K

REG_ADJUST

DBG2_GPIO

D
B

G
3_

C
T

R
L

D
B

G
2_

C
T

R
L

U
P

D
I

U
P

D
I

G
P

IO

G
P

IO

R
E

S
E

T

Si
gn

al

D
B

G
0

D
B

G
1

D
B

G
2

D
B

G
3

IC
S

P
In

te
rf

ac
e

D
A

T

C
L

K

G
P

IO

M
C

L
R

D
B

G
3

C
D

C
 T

X

C
D

C
 R

X

U
A

R
T

 R
X

U
A

R
T

 T
X

U
A

R
T

 R
X

U
A

R
T

 T
X

T
A

R
G

E
T

T
A

R
G

E
T

VBUS_ADC

V
C

C
-

-

V
O

F
F

V
T

G
_A

D
C

D
A

C

ID
_S

Y
S

V
T

G
_E

N

VTG_EN

VBUS_ADC

S
W

D
IO

S
W

D
IO

V
O

F
F

D
E

B
U

G
G

E
R

U
SB

M
IC

R
O

-B
C

O
N

N
E

C
T

O
R

U
S

B
D

_P
U

S
B

D
_N

V
C

C
_P

3V
3

V
B

U
S

D
E

B
U

G
G

E
R

 P
O

W
E

R
/S

T
A

T
U

S 
L

E
D

ID
_S

Y
S

V
C

C
_P

3V
3

ID
_S

Y
S

ID
 P

IN

V
C

C
_V

B
U

S

V
C

C
_E

D
G

E

V
C

C
_T

A
R

G
E

T

S
W

D

SW
D

A
T

S
W

C
L

K

SW
O

/G
P

IO

R
E

S
E

T

U
A

R
T

 R
X

U
A

R
T

 T
X

T
A

R
G

E
T

-

D
E

B
U

G
G

E
R

C
D

C
_T

X

C
D

C
_R

X

V
O

U
T

A
1

V
IN

A
2

V
O

U
T

B
1

V
IN

B
2

G
N

D
C

1
E

N
C

2

M
IC

94
16

3Y
C

S

U
10

8

E
N

1

V
IN

3
V

O
U

T
4

A
D

J
5

G
N

D
2

B
Y

P
6

E
P

7

M
IC

53
53

Y
M

T
-T

R

U
10
2

47
k

R
10
0

47
k

R
10
9

G
N

D

V
C

C
_V

B
U

S

47k

R103 G
N

D
G

N
D

G
N

D

47k

R101

47k

R102

47k

R105

27k

R104 G
N

D
G

N
D

33
k

R
10
6

47k

R111 G
N

D

2.
2u

F
10

V
04

02

C
10
3

G
N

D

0.
1u

F

C
10
2

D
IR

5

A
3

B
4

G
N

D
2

V
C

C
A

1
V

C
C

B
6

74
L

V
C

1T
45

F
W

4-
7

U
10
3

D
IR

5

A
3

B
4

G
N

D
2

V
C

C
A

1
V

C
C

B
6

74
L

V
C

1T
45

F
W

4-
7

U
10
4

D
IR

5

A
3

B
4

G
N

D
2

V
C

C
A

1
V

C
C

B
6

74
L

V
C

1T
45

F
W

4-
7

U
10
5

D
IR

5

A
3

B
4

G
N

D
2

V
C

C
A

1
V

C
C

B
6

74
L

V
C

1T
45

F
W

4-
7

U
10
6

D
IR

5

A
3

B
4

G
N

D
2

V
C

C
A

1
V

C
C

B
6

74
L

V
C

1T
45

F
W

4-
7

U
10
7

G
N

D

V
C

C
_P

3V
3

V
C

C
_P

3V
3

V
C

C
_P

3V
3

V
C

C
_P

3V
3 G

N
D

G
N

D

G
N

D

G
N

D

V
C

C
_L

E
V

E
L

V
C

C
_L

E
V

E
L

V
C

C
_L

E
V

E
L

V
C

C
_L

E
V

E
L

47
k

R
11
3

3

1
2

D
M

N
65

D
8L

F
B

-7
B

Q
1
0
1

G
N

D

1kR
11
0

1kR
10
7

1kR
11
2

+
t

M
C

36
21

3
F

10
0

G
N

D

G
N

D

0.
1u

F
C
10
7

1u
F

C
10
6

A
T

S
A

M
D

21
E

18

PA
D

33

PA
00

1

PA
01

2

PA
02

3

PA
03

4

GND
10

VDDANA
9

PA
04

5

PA
05

6

PA
06

7

PA
07

8

PA08
11

PA09
12

PA10
13

PA11
14

PA14
15

PA15
16

PA
16

17
PA

17
18

PA
18

19
PA

19
20

PA
22

21
U

SB
_S

O
F/

PA
23

22
U

SB
_D

M
/P

A
24

23
U

SB
_D

P/
PA

25
24

PA27
25

RESETN
26

PA28
27

GND
28

VDDCORE
29

VDDIN
30

SWDCLK/PA30
31

SWDIO/PA31
32

U
10

0

0.
1u

F

C
10
8

G
N

D

G
N

D

G
N

D

G
N

D

G
N

D

4.
7u

F
C
10
0

J1
01

J1
00

T
C

K
1

G
N

D
2

T
D

O
3

V
T

re
f

4

T
M

S
5

S
R

S
T

6

T
E

S
T

P
O

IN
T

 A
R

R
A

Y
 2

x3
 J

T
A

G

J1
02

T
P
10
0
T
P
10
1

G
N

D

G
N

D

T
P
10
3

T
P
10
4

1k

R
10
8

S
H

IE
L

D

USB2.0Micro-ABFemale

ID
4

V
B

U
S

1

G
N

D
5

D
-

2

D
+

3

0

J1
05

S
M

L
-P

12
M

T
T

86
R

D
10
0

V
C

C
_V

B
U

S
V

C
C

_P
3V

3

D
E

B
U

G
G

E
R

 R
E

G
U

L
A

T
O

R

2.
2u

F

C
10
1

V
O

U
T

1

V
O

U
T

2

GND
3

E
N

4

N
C

5

V
IN

6

EP
7

M
IC

55
28

-3
.3

Y
M

T
-T

R
U
10
1

G
N

D

G
N

D

2.
2u

F
C
10
4

V
D

B
G

_I
N

18
R

R
11
4 G

N
D

G
N

D

P
ro

gr
am

m
in

g 
co

nn
ec

to
r 

fo
r 

fa
ct

or
y 

pr
og

ra
m

m
in

g 
of

D
eb

ug
ge

r.

M
IC

53
53

:
V

in
: 2

.6
V

 to
 6

V
V

ou
t:

 1
.2

5V
 to

 5
.1

V
Im

ax
: 5

00
m

A
D

ro
po

ut
 (

ty
pi

ca
l)

: 5
0m

V
@

15
0m

A
, 1

60
m

V
 @

 5
00

m
A

A
cc

ur
ac

y:
 2

%
 in

it
ia

l
T

he
rm

al
 s

hu
td

ow
n 

an
d 

cu
rr

en
t l

im
it

M
ax

im
um

 o
ut

pu
t v

ol
ta

ge
 is

 li
m

it
ed

 b
y 

th
e 

in
pu

t v
ol

ta
ge

 a
nd

 th
e 

dr
op

ou
t v

ol
ta

ge
 in

 th
e 

re
gu

la
to

r.
(V

m
ax

 =
 V

in
 -

 d
ro

po
ut

)

J1
00

:
- 

C
ut

-s
tr

ap
 u

se
d 

fo
r 

fu
ll

 s
ep

ar
at

io
n 

of
 ta

rg
et

 p
ow

er
 f

ro
m

 th
e 

le
ve

l s
hi

ft
er

s 
an

d 
on

-b
oa

rd
 r

eg
ul

at
or

s.
- 

F
or

 c
ur

re
nt

 m
ea

su
re

m
en

ts
 u

si
ng

 a
n 

ex
te

rn
al

 p
ow

er
 s

up
pl

y,
 th

is
 s

tr
ap

 c
ou

ld
 b

e 
cu

t f
or

 m
or

e 
ac

cu
ra

te
 m

ea
su

re
m

en
ts

. L
ea

ka
ge

 b
ac

k 
th

ro
ug

h 
th

e 
sw

it
ch

 is
 in

 th
e 

m
ic

ro
 a

m
pe

re
 r

an
ge

.
J1

01
:

- 
F

or
 c

ur
re

nt
 m

ea
su

re
m

en
ts

 u
si

ng
 th

e 
on

-b
oa

rd
 p

ow
er

 s
up

pl
y,

 th
is

 s
tr

ap
 m

us
t b

e 
cu

t a
nd

 a
n 

am
m

et
er

 c
on

ne
ct

ed
 a

cr
os

s.

A
dj

us
ta

bl
e 

ou
tp

ut
 a

nd
 li

m
it

at
io

ns
:

- 
T

he
 D

E
B

U
G

G
E

R
 c

an
 a

dj
us

t t
he

 o
ut

pu
t v

ol
ta

ge
 o

f 
th

e 
re

gu
la

to
r 

be
tw

ee
n 

1.
25

V
 a

nd
 5

.1
V

 to
 th

e 
ta

rg
et

.
- 

T
he

 v
ol

ta
ge

 o
ut

pu
t i

s 
li

m
it

ed
 b

y 
th

e 
in

pu
t (

U
S

B
),

 w
hi

ch
 c

an
 v

ar
y 

be
tw

ee
n 

4.
40

V
 to

 5
.2

5V
- 

T
he

 le
ve

l s
hi

ft
er

s 
ha

ve
 a

 m
in

im
al

 v
ol

ta
ge

 le
ve

l o
f 

1.
65

V
 a

nd
 w

il
l l

im
it

 th
e 

m
in

im
um

 o
pe

ra
ti

ng
 v

ol
ta

ge
 a

ll
ow

ed
 f

or
 th

e 
ta

rg
et

 to
 s

ti
ll

 a
ll

ow
 c

om
m

un
ic

at
io

n.
- 

T
he

 M
IC

94
16

3 
ha

s 
a 

m
in

im
al

 v
ol

at
eg

e 
le

ve
l o

f 
1.

70
V

 a
nd

 w
il

l l
im

it
 th

e 
m

in
im

um
 v

ol
ta

ge
 d

el
iv

er
ed

 to
 th

e 
ta

rg
et

.
- 

F
ir

m
w

ar
e 

co
nf

ig
ur

at
io

n 
w

il
l l

im
it

 th
e 

vo
lt

ag
e 

ra
ng

e 
to

 b
e 

w
it

hi
n 

th
e 

th
e 

ta
rg

et
 s

pe
ci

fi
ca

ti
on

.

M
IC

55
28

:
V

in
: 2

.5
V

 to
 5

.5
V

V
ou

t:
 F

ix
ed

 3
.3

V
Im

ax
: 5

00
m

A
D

ro
po

ut
: 2

60
m

V
 @

 5
00

m
A

P
T

C
 R

es
et

ta
bl

e 
fu

se
:

H
ol

d 
cu

rr
en

t:
 5

00
m

A
T

ri
p 

cu
rr

en
t:

 1
00

0m
A

R
11

3 
is

 r
eq

ui
re

d 
to

 p
ul

l t
he

 
Q

10
1 

ga
te

 to
 a

 d
ef

in
ed

 
va

lu
e 

w
he

n 
th

e 
U

10
0 

is
 n

ot
 

po
w

er
ed

T
P

10
3 

an
d 

T
P

10
4

ar
e 

M
T

G
 H

ol
es

in
 th

e 
co

rn
er

s
of

 th
e 

P
C

B
 in

th
e 

D
E

B
U

G
G

E
R

se
ct

io
n 

la
be

ll
ed

"G
N

D
" 

on
 th

e
si

lk
sc

re
en

.



 
Appendix

© 2022 Microchip Technology Inc.
and its subsidiaries

 User Guide DS70005517A-page 31

11

22

33

44

55

66

77

88

D
D

C
C

B
B

A
A

ds
P

IC
33

C
K

64
M

C
10

5 
C

u
ri

os
it

y 
N

an
o

03
-1

13
56

_C
ur

io
si

ty
_N

an
o_

Ta
rg

et
_M

C
U

.S
ch

D
oc

Pr
oj

ec
t T

it
le

F
il

e:

D
es

ig
n

ed
 w

it
h

P
C

B
 L

ay
ou

t C
on

ta
ct

:
P 

B
re

ed
ve

ld

Sh
ee

t T
it

le

Ta
rg

et
 M

C
U

P
ro

je
ct

 O
w

ne
r:

P 
Y

ed
am

al
e

S
iz

e
A

3

E
V

88
G

73
A

P
ar

tN
um

be
r:

V
ar

ia
nt

:
D

ef
au

lt 
A

ss
em

bl
y

2 
of

 4
8/

2/
20

22
S

C
H

 #
:

D
at

e:
S

he
et

03
-0

02
36

2
P

C
B

 #
:0

4-
11

35
6

R
ev

:
R

ev
:

2
A

lt
iu

m
.c

om

V
C

C
_T

A
R

G
E

T

U
S

E
R

 L
E

D

V
C

C
_T

A
R

G
E

T

U
SE

R
 B

U
T

T
O

N

V
C

C
_E

D
G

E

ds
P

IC
33

C
K

64
M

C
10

5

V
C

C
_E

D
G

E

D
B

G
0

CDC_TX
CDC_RX

DBG2

D
B

G
1

D
B

G
3

D
B

G
2

D
E

B
U

G
G

E
R

 C
O

N
N

E
C

T
IO

N
S

DBG1

DBG3
DBG0

V
O

F
F

ID
_S

Y
S

ID_SYS

VOFF

T
A

R
G

E
T

 B
U

L
K

V
B

U
S

d
sP

IC
33

C
K

64
M

C
10

5

PG
D

3

PG
C

3

G
PI

O
0

M
C

L
R

D
B

G
0

D
B

G
1

D
B

G
2

D
B

G
3

D
eb

ug
ge

r

C
D

C
 T

X

C
D

C
 R

X

U
SA

R
T

 R
X

U
SA

R
T

T
X

V
T

G
3.

0V
 -

 3
.6

VR
B

6

R
D

13

M
C

L
R

R
B

5

R
C

10

R
C

11

N
am

e
P

in

C
D

C
_T

X
C

D
C

_R
X

C
D

C
_R

X
C

D
C

_T
X

D
B

G
2

D
B

G
1

D
B

G
3

D
B

G
0

V
O

F
F

ID
_S

Y
S

0.
1u

F

C
20
1

0.
1u

F
C
20
2

2.
2u

F
10

V
04

02

C
20
5

SML-D12Y1WT86

Y
E

L
D
20
0

G
N

D

1kR
20
3

1kR
20
2

G
N

D

0.
1u

F

C
20
0

G
N

D

G
N

D
G

N
D

G
N

D

V
C

C
_T

A
R

G
E

T

J2
01

J2
03

J2
05

J2
06

J2
02

J2
04

J2
07

J2
08

E
D

G
E

 5
6P

 F
em

al
e 

C
N

A
N

O

R
E

SE
R

V
E

D
1

ID
2

C
D

C
 R

X
3

C
D

C
 T

X
4

D
B

G
1

5

D
B

G
2

6

0 
T

X
7

1 
R

X
8

2 
SD

A
9

3 
S

C
L

10

4 
M

O
SI

11

5 
M

IS
O

12

6 
SC

K
13

7 
SS

14

G
N

D
15

0 
(T

X
)

16

1 
(R

X
)

17

2
18

3
19

0
20

1
21

2
22

3
23

G
N

D
24

G
N

D
33

4
34

5
35

6
36

7
37

4
38

5
39

6
40

7
41

G
N

D
42

A
D

C
0

43
A

D
C

1
44

A
D

C
2

45
PW

M
 3

46
PW

M
 4

47
A

D
C

 5
48

A
D

C
 6

49
A

D
C

 7
50

V
C

C
51

G
N

D
52

D
B

G
0

53
D

B
G

3
54

V
O

FF
55

V
B

U
S

56
D

E
B

U
G

G
E

R

TA
R

G
E

T

0
25

1
26

7
32

6
31

2
27

3
28

5
30

4
29

J2
00

8M
H

z 
C

ry
st

al

10
pF

C
20
6

N
.M

G
N

D
G

N
D

J2
16

J2
14

J2
15

G
N

D

V
C

C
_T

A
R

G
E

T

G
N

D

R
B

1
R

B
0

R
P

46
/P

W
M

1H
/R

B
14

1

R
P

47
/P

W
M

1L
/R

B
15

2

R
P

60
/R

C
12

3

R
P

61
/R

C
13

4

M
C

L
R

5

A
N

N
0/

R
P

77
/R

D
13

6

A
N

12
/R

P
48

/R
C

0
7

O
A

1O
U

T
/A

N
0/

C
M

P
1A

/I
B

IA
S

0/
R

A
0

8

O
A

1I
N

-/
R

A
1

9

O
A

1I
N

+
/A

N
9/

R
A

2
10

D
A

C
O

U
T

/A
N

3/
C

M
P

1C
/R

A
3

11

O
A

3O
U

T
/A

N
4/

IB
IA

S
3/

R
A

4
12

A
V

D
D

13

A
V

S
S

14

O
A

3I
N

-/
A

N
13

/C
M

P
1B

/I
S

R
C

0/
R

P
49

/R
C

1
15

O
A

3I
N

+
/A

N
14

/I
S

R
C

1/
R

P5
0/

R
C

2
16

IB
IA

S
1/

R
P

54
/R

C
6

17

V
D

D
18

V
S

S
19

A
N

15
/I

B
IA

S
2/

R
P

51
/R

C
3

20

O
S

C
I/

C
L

K
I/

A
N

5/
R

P
32

/R
B

0
21

O
S

C
O

/C
L

K
O

/A
N

6/
R

P
33

/R
B

1
22

IS
R

C
3/

R
P

74
/R

D
10

23

IS
R

C
2/

R
P

55
/R

C
7

24

O
A

2O
U

T
/A

N
1/

A
N

7/
C

M
P

1D
/R

P
34

/I
N

T
0/

R
B

2
25

PG
D

2/
O

A
2I

N
-/

A
N

8/
R

P
35

/R
B

3
26

PG
C

2/
O

A
2I

N
+

/R
P

36
/R

B
4

27

R
P

56
/A

S
D

A
1/

S
C

K
2/

R
C

8
28

R
P

57
/A

S
C

L
1/

S
D

I2
/R

C
9

29

R
P

72
/S

D
O

2/
P

C
I1

9/
R

D
8

30

V
S

S
31

V
D

D
32

PG
D

3/
R

P
37

/R
B

5
33

PG
C

3/
R

P
38

/R
B

6
34

T
D

O
/A

N
2/

R
P

39
/R

B
7

35

PG
D

1/
A

N
10

/R
P

40
/S

C
L

1/
R

B
8

36

PG
C

1/
A

N
11

/R
P

41
/S

D
A

1/
R

B
9

37

R
P

52
/R

C
4

38

R
P

53
/R

C
5

39

R
P

58
/R

C
10

40

R
P5

9/
R

C
11

41

V
S

S
42

V
D

D
43

R
P

65
/P

W
M

4H
/R

D
1

44

T
M

S
/R

P
42

/P
W

M
3H

/R
B

10
45

T
C

K
/R

P
43

/P
W

M
3L

/R
B

11
46

T
D

I/
R

P
44

/P
W

M
2H

/R
B

12
47

R
P

45
/P

W
M

2L
/R

B
13

48

ds
PI

C
33

C
K6

4M
C

10
5 

TQ
FP

-4
8

U
20
1

R
C

6_
R

P
54

R
C

3_
R

P
51

_S
PI

_S
S

R
C

12
_R

P
60

R
B

9_
R

P4
1_

A
N

11
R

B
8_

R
P

40
_A

N
10

R
D

1_
R

P
65

_P
W

M
4H

R
C

9_
R

P
57

_I
2C

_A
S

C
L

1
R

C
8_

R
P

56
_I

2C
_A

S
D

A
1

R
C

0_
R

P
48

_S
P

I_
M

O
SI

R
C

1_
R

P
49

_S
P

I_
M

IS
O

R
C

2_
R

P
50

_S
PI

_S
C

K

R
C

10
_R

P5
8_

U
A

R
T

_T
X

R
C

11
_R

P5
9_

U
A

R
T

_R
X

G
N

D

R
D

13
_R

P
77

_S
W

0_
D

B
G

2

R
D

8_
R

P
72

_P
W

M
4L

R
B

4_
R

P3
6_

U
A

R
T

_T
X

R
B

3_
R

P3
5_

U
A

R
T

_R
X

R
B

6_
R

P3
8_

PG
C

3
R

B
5_

R
P3

7_
PG

D
3

R
C

5_
R

P5
3_

U
A

R
T

_R
X

R
C

4_
R

P5
2_

U
A

R
T

_T
X

R
C

13
_R

P
61

R
B

15
_R

P
47

_P
W

M
1L

R
A

4_
A

N
4

R
A

3_
A

N
3

R
A

2_
A

N
9

M
C

L
R

R
A

0_
A

N
0

R
A

1

R
B

0_
R

P
32

_O
S

C
I

R
B

1_
R

P
33

_O
S

C
O

R
B

2_
R

P
34

_A
N

1_
A

N
7

R
B

7_
R

P
39

_A
N

2

R
B

10
_R

P
42

_P
W

M
3H

R
B

11
_R

P
43

_P
W

M
3L

R
B

12
_R

P
44

_P
W

M
2H

R
B

13
_R

P
45

_P
W

M
2L

R
B

14
_R

P
46

_P
W

M
1H

14

23

TA
C

T
 S

P
S

T
S
W
20
0

R
D

10
_R

P
74

_L
E

D
0

R
C

7_
R

P
55

R
C

10
_R

P5
8_

U
A

R
T

_T
X

R
C

11
_R

P5
9_

U
A

R
T

_R
X

R
B

6_
R

P3
8_

PG
C

3
R

D
13

_R
P

77
_S

W
0_

D
B

G
2

R
B

4_
R

P3
6_

U
A

R
T

_T
X

R
B

3_
R

P3
5_

U
A

R
T

_R
X

R
C

9_
R

P
57

_I
2C

_A
S

C
L

1
R

C
8_

R
P

56
_I

2C
_A

S
D

A
1

R
C

3_
R

P
51

_S
PI

_S
S

R
C

0_
R

P
48

_S
P

I_
M

O
SI

R
C

1_
R

P
49

_S
P

I_
M

IS
O

R
C

2_
R

P
50

_S
PI

_S
C

K

R
C

6_
R

P
54

R
C

5_
R

P5
3_

U
A

R
T

_R
X

R
C

4_
R

P5
2_

U
A

R
T

_T
X

R
C

7_
R

P
55

R
C

12
_R

P
60

R
C

10
_R

P5
8_

U
A

R
T

_T
X

R
C

11
_R

P5
9_

U
A

R
T

_R
X

R
C

13
_R

P
61

R
B

0_
R

P
32

_O
S

C
I

R
B

1_
R

P
33

_O
S

C
O

R
D

13
_R

P
77

_S
W

0_
D

B
G

2
R

D
10

_R
P

74
_L

E
D

0

R
A

1

R
B

15
_R

P
47

_P
W

M
1L

R
B

10
_R

P
42

_P
W

M
3H

R
B

11
_R

P
43

_P
W

M
3L

R
B

12
_R

P
44

_P
W

M
2H

R
B

13
_R

P
45

_P
W

M
2L

R
B

14
_R

P
46

_P
W

M
1H

R
D

1_
R

P
65

_P
W

M
4H

R
D

8_
R

P
72

_P
W

M
4L

R
A

4_
A

N
4

R
A

3_
A

N
3

R
A

2_
A

N
9

R
A

0_
A

N
0

R
B

9_
R

P4
1_

A
N

11
R

B
8_

R
P

40
_A

N
10

R
B

7_
R

P
39

_A
N

2
R

B
2_

R
P

34
_A

N
1_

A
N

7

R
B

5_
R

P3
7_

PG
D

3
M

C
L

R

RD10_RP74_LED0

RD13_RP77_SW0_DBG2

RB0_RP32_OSCI

RB1_RP33_OSCO

0.
1u

F
C
20
3

G
N

D

V
C

C
_T

A
R

G
E

T
0RR
20
0

P
R

O
G

/D
E

B
U

G
 P

u
ll

G
N

D

D
B

G
0

D
B

G
1

V
C

C
_T

A
R

G
E

T

M
C

L
R

 P
u

ll

47
k

R
20
1

47
k

R
20
4

47
k

R
20
5

1
8M

H
z

Y
20
1

N
.M

10
pF

C
20
7

N
.M

0.
1u

F

C
20
4

N
.M

G
N

D

N
O

T
E

 o
n 

U
A

R
T

/C
D

C
:

R
X

/T
X

 o
n 

th
e 

he
ad

er
 d

en
ot

es
 th

e 
in

pu
t/

ou
tp

ut
 

di
re

ct
io

n 
of

 th
e 

si
gn

al
 r

es
pe

ct
iv

e 
to

 it
's

 s
ou

rc
e.

C
D

C
 T

X
 is

 o
ut

pu
t f

ro
m

 th
e 

D
E

B
U

G
G

E
R

.
C

D
C

 R
X

 is
 in

pu
t t

o 
th

e 
D

E
B

U
G

G
E

R
.

U
A

R
T

 T
X

 is
 o

ut
pu

t f
ro

m
 th

e 
T

A
R

G
E

T
 d

ev
ic

e.
U

A
R

T
 R

X
 is

 in
pu

t t
o 

th
e 

T
A

R
G

E
T

 d
ev

ic
e.

N
O

T
E

 o
n 

I2
C

:

N
o 

pu
ll

-u
ps

 o
n 

bo
ar

d.
 P

ul
l-

up
s 

sh
ou

ld
 b

e 
m

ou
nt

ed
 c

lo
se

 to
 c

li
en

t d
ev

ic
e(

s)
.

Y
20

1 
is

 a
 f

oo
tp

ri
nt

 f
or

 a
 s

ta
nd

ar
d 

5x
3.

2m
m

 c
ry

st
al

. 

To
 u

se
 a

 c
ry

st
al

 w
it

h 
th

e 
ds

P
IC

33
C

K
 o

sc
il

la
to

r 
pe

rf
or

m
 

th
ef

ol
lo

w
in

g 
st

ep
s:

 
1.

 M
ou

nt
 a

 c
ry

st
al

 o
n 

th
e 

Y
20

1 
fo

ot
pr

in
t 

2.
 S

ho
rt

-c
ir

cu
it

 J
20

7 
an

d 
J2

08
 to

 c
on

ne
ct

th
e 

cr
ys

ta
l t

o 
th

e 
os

ci
ll

at
or

 p
in

s 
3.

 C
ut

 J
21

4 
an

d 
J2

15
 to

 d
is

co
nn

ec
t t

he
 s

ig
na

ls
 f

ro
m

 th
e 

bo
ar

d 
ed

ge
 

O
pt

io
na

l:
 

M
ou

nt
 c

ap
ac

it
or

s 
on

 C
20

6 
an

d 
C

20
7 

to
 tu

ne
 th

e 
cr

ys
ta

l 
os

ci
ll

at
io

n 
ci

rc
ui

t 
C

ut
 J

21
6 

an
d 

re
pl

ac
e 

w
it

h 
re

si
st

or
s 

to
 p

er
fo

rm
 o

sc
il

la
to

r 
al

lo
w

an
ce

 m
ea

su
re

m
en

ts



 
Appendix

© 2022 Microchip Technology Inc.
and its subsidiaries

 User Guide DS70005517A-page 32

7.2 Assembly Drawing
Figure 7-2. dsPIC33CK64MC105 Curiosity Nano Assembly Drawing Top

Figure 7-3. dsPIC33CK64MC105 Curiosity Nano Assembly Drawing Bottom
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7.3 Curiosity Nano Base for Click boards™

Figure 7-4. dsPIC33CK64MC105 Curiosity Nano Pinout Mapping
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7.4 Disconnecting the On-Board Debugger
The on-board debugger and level shifters can be completely disconnected from the dsPIC33CK64MC105.

The block diagram below shows all connections between the debugger and the dsPIC33CK64MC105. The rounded
boxes represent connections to the board edge. The signal names shown are also printed in silkscreen on the bottom
side of the board.

To disconnect the debugger, cut the straps shown in Figure 7-6.

Attention: Cutting the GPIO straps to the on-board debugger will disable the virtual serial port,
programming, debugging, and data streaming. Cutting the power supply strap will disconnect the on-board
power supply.

Tip: Reconnect any cut connection by using solder. Alternatively, mount a 0Ω 0402 resistor.

Tip: When the debugger is disconnected, an external debugger can be connected to holes, as shown
in Figure 7-6. Details about connecting an external debugger are described in 3.6.  Connecting External
Debuggers.

Figure 7-5. On-Board Debugger Connections Block Diagram
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Figure 7-6. On-Board Debugger Connection Cut Straps

GPIO straps (bottom side) Power Supply strap (top side)
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The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within operating

specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the code

protection features of Microchip product is strictly prohibited and may violate the Digital Millennium Copyright
Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code
protection does not mean that we are guaranteeing the product is “unbreakable”. Code protection is constantly
evolving. Microchip is committed to continuously improving the code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including to design, test,
and integrate Microchip products with your application. Use of this information in any other manner violates these
terms. Information regarding device applications is provided only for your convenience and may be superseded
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by updates. It is your responsibility to ensure that your application meets with your specifications. Contact your
local Microchip sales office for additional support or, obtain additional support at www.microchip.com/en-us/support/
design-help/client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE,
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the buyer agrees
to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights
unless otherwise stated.
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Quality Management System
For information regarding Microchip’s Quality Management Systems, please visit www.microchip.com/quality.
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